
Automatic Transfer Switches

Models:

MPAC Setup Program

Applies to:

MPAC-1000� Transfer Switch Controllers

TP-6135 4/02

Software Operation
and Installation



Product Identification Information

Software Version Number

Record the software version number.

Software Version Number

x:in:007:001a



Table of Contents

TP-6135 4/02 Table of Contents

Product Identification Information Inside front cover. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Safety Precautions and Instructions I. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Introduction i. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Service Assistance i. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 1 Requirements and Installation 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.1 Introduction 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.2 System Requirements 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.3 Hardware Connections 1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.3.1 Serial Port Connection 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.3.2 Modbus Connections 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.4 Software Installation 3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.4.1 Installation 3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1.4.2 Uninstallation 3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 2 Software Operation 5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.1 Introduction 5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.2 Getting Started 5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.3 Login 6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.4 Main Window 6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.5 Connection Menu 6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.6 Tools Menu 6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.6.1 Change Password 6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.6.2 Change User Name 7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.6.3 Options 7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.7 Window Menu 7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.7.1 New Window 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.7.2 Setup 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Working with Setup Windows 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.7.3 Arrange Icons 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.7.4 Cascade Windows 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.7.5 Display Windows 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.8 File Menu 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.8.1 Save Screen and Open Screen 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.8.2 Save and Restore Setup 10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.8.3 Exit 10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.9 Edit Menu 11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.10 Help Menu 11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.11 System Tray 11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2.12 Messages 12. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 3 Setup Software Windows 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.1 Introduction 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.2 Date/Time Windows 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.2.1 Date/Time Display 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.2.2 Date/Time Setup 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.2.3 Daylight Saving Time 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.3 Source Information 13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.3.1 Source Info Display 14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.3.2 Source Info Setup 14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.4 Setpoints, Frequency 15. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.4.1 Display 15. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.4.2 Setup 15. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.5 Setpoints, Voltage 16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.5.1 Display 16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



Table of Contents, continued

TP-6135 4/02Table of Contents

3.5.2 Setup 16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.6 System Information 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.6.1 System Information Display 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.6.2 System Information Setup 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.7 System Summary 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.7.1 System Summary Display 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.7.2 System Summary Setup 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.8 DIP Switch Settings 20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.9 Active Time Delay 20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.10 Time Delays 21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.10.1 Time Delay Display Window 21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.10.2 Time Delay Setup Window 21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.10.3 Time Delays 22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.11 Load Control Time Delays 22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.11.1 Display 22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.11.2 Setup 23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.12 Programmable Input/Output 24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.12.1 I/O Display Window 24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.12.2 I/O Setup Window 24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.12.3 Programmable Inputs 25. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.12.4 Programmable Outputs 26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.13 Exerciser 27. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.13.1 Exerciser Display Window 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.13.2 Exerciser Setup Window 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.14 Exercise Calendar 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.14.1 Calendar Display Window 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.14.2 Calendar Setup Window 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.15 Common Alarms 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.15.1 Common Alarms Display Window 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.15.2 Common Alarm Setup Window 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.16 Event History 33. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.17 Maintenance 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.17.1 Maintenance Display Window 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.17.2 Maintenance Setup Window 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.18 Manual Operation 35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.19 Meter Calibration 36. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.20 Network Interface Port 37. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.20.1 Network Interface Port Display Window 37. . . . . . . . . . . . . . . . . . . . . . . . . .

3.20.2 Network Interface Port Setup Window 37. . . . . . . . . . . . . . . . . . . . . . . . . . . .

3.21 Software Window Summary 38. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Appendix A Abbreviations A-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



TP-6135 4/02 ISafety Precautions and Instructions

Safety Precautions and Instructions

IMPORTANT SAFETY

INSTRUCTIONS. Electromechanical

equipment, including generator sets,

transfer switches, switchgear, and

accessories, can cause bodily harm

and pose life-threatening danger when

improperly installed, operated, or

maintained. To prevent accidents be

aware of potential dangers and act

safely. Read and follow all safety

precautions and instructions. SAVE

THESE INSTRUCTIONS.

Thismanual hasseveral typesofsafety

precautions and instructions: Danger,

Warning, Caution, and Notice.

DANGER

Danger indicates the presence of a

hazard that will cause severe

personal injury,death, orsubstantial

property damage.

WARNING

Warning indicates the presence of a

hazard that can cause severe

personal injury,death,orsubstantial

property damage.

CAUTION

Caution indicates the presence of a

hazard that will or can cause minor

personal injury or property damage.

NOTICE

Notice communicates installation,

operation, or maintenance information

that is safety related but not hazard

related.

Safety decals affixed to the equipment

in prominent places alert the operator

or service technician to potential

hazards and explain how to act safely.

The decals are shown throughout this

publication to improve operator

recognition. Replace missing or

damaged decals.

Accidental Starting

Accidental starting.

Can cause severe injury or death.

Disconnect the battery cables before

working on the generator set.

Remove the negative (--) lead first

when disconnecting the battery.

Reconnect the negative (--) lead last

when reconnecting the battery.

WARNING

Disabling the generator set.

Accidental starting can cause

severe injury or death. Before

working on the generator set or

connected equipment, disable the

generator set as follows: (1) Move the

generator set master switch to theOFF

position. (2) Disconnect the power to

the battery charger. (3) Remove the

battery cables, negative (--) lead first.

Reconnect the negative (--) lead last

when reconnecting the battery. Follow

these precautions to prevent starting of

the generator set by an automatic

transfer switch, remote start/stop

switch, or engine start command froma

remote computer.

Hazardous Voltage/

Electrical Shock

Hazardous voltage.

Will cause severe injury or death.

Disconnect all power sources before

opening the enclosure.

DANGER

Hazardous voltage.

Will cause severe injury or death.

Only authorized personnel should

open the enclosure.

DANGER

Hazardous voltage.

Can cause severe injury or death.

Operate the generator set only when

all guards and electrical enclosures

are in place.

Moving rotor.

WARNING

Short circuits. Hazardous

voltage/current can cause severe

injury or death. Short circuits can

cause bodily injury and/or equipment

damage. Do not contact electrical

connections with tools or jewelry while

making adjustments or repairs.

Removeall jewelrybefore servicing the

equipment.

Testing live electrical circuits.

Hazardous voltage or current can

cause severe injury or death. Have

trained and qualified personnel take

diagnostic measurements of live

circuits. Use adequately rated test

equipment with electrically insulated

probesand follow the instructionsof the

test equipment manufacturer when

performing voltage tests. Observe the

following precautions when performing

voltage tests: (1) Remove all jewelry.

(2)Standonadry, approvedelectrically

insulated mat. (3) Do not touch the

enclosure or components inside the

enclosure. (4) Be prepared for the

system to operate automatically.

(600 volts and under)
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Moving Parts

Hazardous voltage.

Can cause severe injury or death.

Operate the generator set only when

all guards and electrical enclosures

are in place.

Moving rotor.

WARNING

Notice

NOTICE

Hardware damage. The transfer

switch may use both American

Standard and metric hardware. Use

the correct size tools to prevent

rounding of the bolt heads and nuts.

NOTICE

Electrostatic discharge damage.

Electrostatic discharge (ESD)

damages electronic circuit boards.

Prevent electrostatic discharge

damage by wearing an approved

grounding wrist strap when handling

electronic circuit boards or integrated

circuits. An approved grounding wrist

strap provides a high resistance (about

1 megohm), not a direct short, to

ground.
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Introduction

This manual covers the installation and operation of the

MPAC Setup Program for personal computers running

the Windows� operating system.

Information in this publication represents data available

at the time of print. Kohler Co. reserves the right to

change this literature and the products represented

without notice and without any obligation or liability

whatsoever.

Read this manual and carefully follow all procedures

and safety precautions to ensure proper equipment

operation and to avoid bodily injury. Read and follow the

Safety Precautions and Instructions section at the

beginning of this manual. Keep this manual with the

equipment for future reference.

The software covered by this manual is part of a total

control system. Separate manuals provide specific

information about transfer switch operating limits,

specifications, and functions. The related manual

numbers follow.

Manual
Part

Number

Model KCT, KCP Operation and
Installation Manual

TP-6126

Model KBT, KBP Bypass/Isolation Switch
Operation and Installation Manual

TP-6128

Service Assistance

For professional advice on generator power

requirements and conscientious service, please contact

your nearest Kohler distributor or dealer.

� Consult the Yellow Pages under the heading

Generators—Electric

� Visit the Kohler Power Systems website at

KohlerPowerSystems.com

� Look at the labels and stickers on your Kohler product

or review the appropriate literature or documents

included with the product

� Call toll free in the US and Canada 1-800-544-2444

� Outside the US andCanada, call the nearest regional

office

Africa, Europe, Middle East

London Regional Office

Langley, Slough, England

Phone: (44) 1753-580-771

Fax: (44) 1753-580-036

Asia Pacific

Power Systems Asia Pacific Regional Office

Singapore, Republic of Singapore

Phone: (65) 264-6422

Fax: (65) 264-6455

China

North China Regional Office, Beijing

Phone: (86) 10 6518 7950

(86) 10 6518 7951

(86) 10 6518 7952

Fax: (86) 10 6518 7955

East China Regional Office, Shanghai

Phone: (86) 21 6288 0500

Fax: (86) 21 6288 0550

India, Bangladesh, Sri Lanka

India Regional Office

Bangalore, India

Phone: (91) 80 3366208

(91) 80 3366231

Fax: (91) 80 3315972

Japan, Korea

North Asia Regional Office

Tokyo, Japan

Phone: (813) 3440-4515

Fax: (813) 3440-2727

Latin America

Latin America Regional Office

Lakeland, Florida, USA

Phone: (863) 619-7568

Fax: (863) 701-7131
X:in:008:001a

Windows� is a registered trademark of Microsoft Corporation.
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Section 1 Requirements and Installation

1.1 Introduction

The MPAC Setup Program allows viewing and

adjustment of the system parameters of a transfer

switch equipped with the MPAC-1000� programmable

transfer switch controller. Use the software to:

� View and adjust:

� Source parameters

� Time delays

� Voltage and frequency trip points

� Exerciser settings

� Date and time

� Other settings

� View:

� System status

� DIP switch settings

� Event history

� Maintenance records

� Start and stop a system test, exercise, or peak shave

sequence

� Transfer to the OFF position (programmed-transition

models only)

� Assign programmable inputs and outputs

� Toggle Modbus�-controlled relay outputs

1.2 System Requirements

The minimum system requirements to run the program

are:

� 133MHz or higher Intel� Pentium�-compatible CPU

� 32 MB RAM

� CD-ROM drive and 75MB hard drive space available

for installation

� 800 x 600 or better color monitor

� Microsoft Windows� 95, Windows� 98, Windows NT�

4.0, Windows� 2000*, or Windows XP� operating

system with Internet Explorer version 4.0 or higher

� Serial port configured as COM 1--16

� Null-modem cable (included with the software kit)

1.3 Hardware Connections

Hazardous voltage.

Will cause severe injury or death.

Only authorized personnel should

open the enclosure.

DANGER

Short circuits. Hazardous voltage/current can cause

severe injury or death. Short circuits can cause bodily injury

and/or equipment damage. Do not contact electrical

connections with tools or jewelry whilemaking adjustments or

repairs. Remove all jewelry before servicing the equipment.

* We are aware of problems with certain computers running
Windows� 2000 and communicating through serial ports. These
particular computers have internally simulated serial ports using
USB inputs instead of true serial ports. Microsoft WIndows� 2000
Service Pack III, to be released in the near future, will reportedly
address this problem. The use of a serial adapter card to connect
thePC to theATS controller has been shown to correct this problem
(the Socket� PCMCIA Serial Adapter card is one example).

Modbus� is a registered trademark of Schneider Electric.
Windows�, Windows NT�, and Windows XP� are registered trademarks of Microsoft Corporation.
Intel� and Pentium� are registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.
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1.3.1 Serial Port Connection

Use a serial port connection to connect a personal

computer (PC) running the setup software to the ATS

controller.

Use a null modem cable (Kohler part numberGM16657,

included with the software kit) to connect the PC to the

ATS controller. Connect the cable to one of the PC’s

serial ports and note the port number to enter into the

software communication settings as directed in Section

2.6.3, Program Options. Open the ATS enclosure door

and connect the other end of the cable to the controller’s

serial port, P6, shown in Figure 1-1.

GM21364

1. Serial port for PC connection (P6)

2. Ground wire
3. Terminal strip (inputs, output, Modbus connections) (TB1)

1

3

2

Figure 1-1 ATS Controller Connections

1.3.2 Modbus Connections

To install the transfer switch in a Modbus network, use

12-24 AWG twisted-pair cable (Belden cable #9841 or

equivalent) to connect to either set of Modbus terminals

on the ATSmain logic board terminal strip TB1 shown in

Figure 1-2. Connect the shield to ground as shown in

Figure 1-2. Tighten the connections to 0.5 Nm

(4.4 in. lb.).

Note: Contact Kohler Co. for information about

Modbus� communication protocol.

GM22366

A (--)

A (--)

B (+)

B (+)

MODBUS RS485

PROGRAMMABLE
INPUT 1

PROGRAMMABLE
INPUT 2

PROGRAMMABLE
OUTPUT

TRANSFER
PRE-SIGNAL

10A@30VDC/250VAC

2A@30VDC/250VAC

MODBUS RS485

Figure 1-2 Terminal Strip TB1 Connections
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1.4 Software Installation

For simplicity, this manual and the software assumes

that the PC has the CD-ROM drive installed as the D:

drive and the hard drive installed as the C: drive. If your

drive locations are different, type in the correct drive

letter for your PC hard drive or CD-ROM drive when

applicable during software installation or operation.

1.4.1 Installation

TheSetup Program softwareCD-ROMcontains various

files that are used by the setup program to install the

software on the PC. The setup program automatically

installs a shortcut to run the program from the Start

menu.

Follow the steps below to install the Setup Program in

Windows�.

Software Installation Procedure

1. Close all applications.

2. Insert the Setup Program software CD-ROM into

the PC’s CD-ROM drive, the D: drive on most

systems.

3. Open Windows� Explorer and double-click on the

CD-ROM drive.

4. Double click on the SetupProgK.exe file to install

the program.

5. The setup program reminds you to close all

applications. Close other applications and click the

OK button.

6. Click on the Change Directory box to change the

installation directory, if desired. The setup program

creates and installs the main software files into the

C:\Program Files\SetupProgK directory unless an

alternate location is provided.

7. Click on the computer icon to begin the installation

process.

8. Enter information into the dialog box to change the

locations of the program group and shortcut, if

desired. Click the Continue button to begin

copying the files.

9. Click the OK button after the setup is completed.

10. Remove theCD-ROMand store it in a safe location

away from excessive heat, direct sunlight, and

moisture.

When the program runs, it generates other files in the

installation directory that the program uses to store

system information.

Perform regular backups of the installation directory.

1.4.2 Uninstallation

To remove the software from the PC, select

Settings>Control Panel>Add/Remove Programs from

the Start menu. Select the SetupProgK group and click

on Add/Remove. An uninstallation program runs and

deletes installed Setup Program files from the

installation directory.

Note: Do not simply delete the software files.

Windows�, Windows NT�, and Windows XP� are registered trademarks of Microsoft Corporation.
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Notes
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Section 2 Software Operation

2.1 Introduction

This section provides general instructions for working

with the Setup Program tools and windows. Detailed

descriptions of the individual display and setup windows

are given in Section 3, Setup Software Windows.

2.2 Getting Started

This section explains the procedure to start the Setup

Program and use it to display and change transfer

switch settings. Sections 2.3 through 2.10 give more

detailed descriptions of toolbar functions and

commands.

1. Start the program by clicking on the Start button at

the lower left corner of the personal computer (PC)

screen and selecting Programs>MPAC Setup

Program.

2. Log in when prompted by entering the user name

and password. The default user name and

password are shown in Figure 2-1.

Note: User names and passwords are case

sensitive.

Note: Change the user name and password to

prevent unauthorized personnel from using

the program to change system settings.

3. From the menu toolbar at the top of the screen,

select Tools. Scroll down to the last item in the list

and select Options. Enter the number of the PC’s

communication port that is connected to the

controller into the data box labeled COM Port.

Type the number into the box or use the up and

down arrows to select it. See Section 2.6.3,

Program Options.

4. From the menu toolbar at the top of the screen,

select Connection. Scroll down to highlight

Connect and click on it to connect the PC to the

transfer switch controller. Check that the icon in the

lower right corner of the PC screen shows that the

PC is connected to the ATS controller. See Section

2.11, System Tray.

User Name ATS

Password T340

Figure 2-1 Default Login Name and Password

5. From the menu toolbar at the top of the screen,

select Window. Scroll down to highlight New

Window and click. Use the cursor to select a

window from the list displayed on the screen and

click to select that window. The selected display

window will appear on the screen.

Note: SeeSection 3, Setup SoftwareWindows, for

descriptions of data windows.

6. To change settings:

a. Create the display window that shows the

setting you want to change or click on it if it is

already displayed on the screen.

b. SelectWindow>Setup from theMenu toolbar at

the top of the screen. The setup window will

appear.

c. Each adjustable parameter uses either a radio

button, a check box, or a data entry box to

change the setting. Click on the radio buttons

or check boxes to change selected settings.

The acceptable range of values is listed next to

most data entry boxes; use the drop-down

arrows to select a new setting or click in the box

and type in a new value within the acceptable

range. Refer to the appropriate sections

following this procedure for more detailed

instructions for each window and setting.

d. Click onOK or press the Enter key to apply the

changes. Click on Cancel to discard the

changes.

e. Watch the display window for the updated

settings. The update time will vary with the

number of windows displayed on the screen

and the scan rate (see Section 2.6.3).

7. Arrange the windows on the screen by using

Window>Cascade Windows, if desired, or by

dragging and dropping windows.

8. Save screens and settings if desired for future use.

See Section 2.8.1, Save and Open Screen, and

Section 2.8.2, Save and Restore Setup, for

instructions.

9. When finished, choose Connection>Disconnect to

disconnect the PC from the controller.

10. Choose File>Exit to exit and close the Setup

Program.
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2.3 Login

At startup, the programdisplays the login windowshown

in Figure 2-2. Enter the user name and password and

click on the OK button.

The default password is T340. Change the user name

and password to prevent unauthorized personnel from

using the program to view system information or change

system settings.

Name

Figure 2-2 Login Screen

2.4 Main Window

After login, the program displays the Main window

shown in Figure 2-3. Use the buttons at the upper right

corner to resize, minimize, or maximize the main

window.

Use the pull-down menus at the top of the main window

to access the commands shown in the following

sections.

Figure 2-3 Main Window

2.5 Connection Menu

The Connect command attempts to open the

communication port and establish communications with

a connected controller. See Section 2.6.3, Program

Options, to set the number of the PC’s communication

port. See Figure 2-4.

The Disconnect command closes the communication

port. Be sure to disconnect before exiting the setup

program.

Figure 2-4 Connection Menu

2.6 Tools Menu

Use the Tools menu to change the software user name

and password and to set the PC’s communication

settings. See Figure 2-5.

Figure 2-5 Tools Menu

2.6.1 Change Password

This window allows the user to change the password.

See Figure 2-6. The window displays the name of the

user logged on to the program. Type in the old

password, the new password, and the new password a

second time for confirmation. To ensure confidentiality,

the passwords do not appear on the screen. Click on the

OK button to enter the new password. Click on the
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Cancel button to discard the changes and keep the old

password.

Note: Passwords and user names are case sensitive.

Check the Caps Lock key when typing

passwords.

Figure 2-6 Change Password

2.6.2 Change User Name

Use this window to change the user name of the person

who is logged in. See Figure 2-7. The window displays

the current user namenear the top. Type in the newuser

name and type it again in the second box to confirm it.

The new names appear on the screen as they are typed.

Click onOK to accept the new user names, or Cancel to

discard the change and keep the old user name.

The program verifies that the new names match before

accepting the change.

Note: Passwords and user names are case sensitive.

John Smith

Figure 2-7 Change User Name

2.6.3 Options

Enter the number of the PC’s communication port that is

connected to the controller. Type the number into the

box or use the up and down arrows to select it. See

Figure 2-8. If you are uncertain of the COM port

number, select COM Port numbers and try to connect

until connection is established. (See Section 2.5,

Connection Menu, and Section 2.11, System Tray.)

The scan rate affects the time required to update

settings and display windows. However, the update

time is more strongly affected by the number of windows

displayed on the screen. Recommended scan rates are

200--300milliseconds. Faster scan rates (less than 200

milliseconds) may cause data loss and are not

recommended.

Click on the OK button to apply the changes.

Figure 2-8 Options

2.7 Window Menu

Use theWindowmenu to create new windows, select a

window, enter the setup screen for an existing window,

arrange windows on the screen, and delete windows.

This section gives general instructions for creating

display and setup windows. Refer to Section 3, Setup

Software Windows, for detailed descriptions of the

contents and use of of each window. See Figure 2-9.

Figure 2-9 Window Menu
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2.7.1 New Window

Select Window>New Window... from the main window

pull-down menus. The program displays the Add

Window form shown in Figure 2-10. The list box

displays all available windows. Display a window on the

user screen by selecting it from the list and then clicking

OK. Select multiple items from the list by holding down

the control (Ctrl) key and clicking on each item. Select

blocks of items by clicking on the first item, then holding

down the Shift key while clicking on the last item in the

block.

Windows that have already been added to the user

screen do not appear on the list. If all windows have

been added to the user screen, the list is empty.

Click on Cancel or the X button at the upper right corner

of the form to return to the main window.

See Section 3, Setup Software Windows, for detailed

instructions for the different windows.

Figure 2-10 Add Window Form

2.7.2 Setup

The setupwindow allows you to change user-adjustable

settings within the window. For example, the Source

Info setup window allows you to change the system

voltage, frequency, number of phases, and expected

phase rotation for each source.

Note: Youmust select the Display window for a function

before you can open the Setup window.

First select the display window for the ATS function that

you want to work with. Then choose Window>Setup or

double-click on the active display window to open the

setup window for that function.

Working with Setup Windows

The setup windows use several methods to enter

system information and settings. This section gives

general instructions about how to use the different

methods to enter information.

Radio Buttons. A radio button appears as an open

circle. Position the cursor inside the open circle and

left-click to select the desired option. The selected radio

button has a dark dot in the center. Radio buttons allow

the selection of only one of the options in a set.

Selecting one radio button in a set of options deselects,

or turns off, all of the other options.

Check Boxes. Check boxes are open rectangular

boxes. A selected check box contains a check mark.

Position the cursor inside the box and click to select or

deselect the option. Check boxes allow the selection of

any or all of the options in the set. Selecting one option

with a check box will not deselect the other options in a

set.

Data Entry Boxes. Data entry boxes allow you to type

in text or numerical data from the keyboard. Position the

cursor inside the box, left-click, and type in the new

information. If the box already contains information,

double-click to highlight the text before typing the new

information. Some items show the acceptable range of

settings after the data entry box. Verify that the data you

enter falls within the range shown. If the setting does not

fall within the acceptable range, the systemwill not enter

the change.

Drop-Down Arrows. A drop-down arrow appears as a

down arrow in a box at the end of a line. Position the

cursor on the down arrow and click to display a selection

list. Click on an item in the list to select it. The selected

item appears in the box next to the arrow.

Up and Down Arrows. Up and down arrows appear in

boxes after a data entry box containing a numerical

setting. Click on the up arrow to increase the number or

the down arrow to decrease the number. You can also

double-click inside the data box and type in the setting

directly, provided it falls within the acceptable range.
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OK and Cancel Buttons. The OK and Cancel buttons

appear at the bottom of each window. The software

does not enter changes until the OK button is clicked.

Make changes to the selections or data entry boxes, and

then click on OK to accept the changes and enter them

into the system. If the OK box is highlighted on the

screen, pressing the Enter key will also enter the

changes. Click on Cancel to discard the changes

without entering them into the system.

Confirmation Boxes. Clicking on OK to enter some

changes prompts a confirmation box to appear on the

screen before the system enters the changes. Double

check your selections and their effect on the system

before clicking on OK to confirm the changes.

2.7.3 Arrange Icons

Minimizing windows by clicking on the
--

symbol in the

upper right corner of the window reduces the window to

an icon. Select Window>Arrange Icons to arrange the

icons neatly at the bottom of the main window.

2.7.4 Cascade Windows

Choose Window>Cascade Windows to arrange the

windows on the screen. The Cascade Windows

command is enabled only when two or more display

windows are on the screen.

2.7.5 Display Windows

Choose Windows>Display Windows to see a list of all

windows that have been created on the screen. Select a

window from the list to bring it to the top and activate it.

2.8 File Menu

The file menu includes the following options:

� Open Screen

� Save Screen

� Save Screen As

� Restore Setup

� Save Setup

� Exit

See Figure 2-11.

Figure 2-11 File Menu

2.8.1 Save Screen and Open Screen

A layout of data windows can be saved to a file for reuse.

After creating the desired display windows and

arranging them on the PC screen, use the following

procedure to save the layout. Use the Save Screen As

command to create a new file or Save Screen to update

an existing Screen file.

Note: The Save Screen command does not save

system settings (source parameters, time delay

settings, etc.). Use the Save Setup command to

save system settings. See Section 2.8.2, Save

and Restore Setup.

Procedure to Save a Screen to a File

1. Select File>Save Screen As from the menu bar as

shown in Figure 2-11.

2. A dialogue box appears. See Figure 2-12. Type in

a filename for the screen file. Choose a unique

name that identifies the file for future reference.

Screen files use the extension .scn. Donot type the

filename extension; the program appends the

extension to the filename automatically.

3. Click on the Save button.

Figure 2-12 Save Screen



TP-6135 4/0210 Section 2 Software Operation

The Open Screen command opens a file containing

previously created display windows.

Select File>Open Screen and then select the

appropriate file from the list on the screen. Use the

drop-down arrows to change directories if the file is

located in a different directory than the one displayed in

the Look in: box. With the file selected, click on theOpen

button. The saved screens appear in the programs

main window when the file opens.

2.8.2 Save and Restore Setup

Save Setup saves system settings (time delays, pickup

and dropout settings, etc.) to a file for future reference or

restoration. Here are some examples of how these

commands may be used:

� To save the system settings from each controller in a

separate file on the computer or on a disk for future

reference and troubleshooting

� To save the system settings before running tests and

diagnostics on the controller

� To save the system settings from one ATS controller

to load onto another ATS controller of the same type

� To save settings for two modes of operation for the

controller, such as Normal Operation and Test

Settings where the Test Settings use different time

delays and exercise run times than the Normal

Operation mode

Note: The ATS controller’s system settings are not lost

during power outages.

Saving the settings immediately after the system setup

is completed or updated is strongly recommended. If

the controller requires replacement or updated

application software in the future, the settings file can be

used to restore the operating settings quickly and

accurately.

Procedure to Save System Settings to a File

1. Use the display and setup windows to enter all of

the desired system settings including source

parameters, voltage and frequency pickup and

dropout settings, time delays, programmable

input/output assignments, exerciser settings, and

other adjustable settings.

2. Select File>Save Setup from the menu bar as

shown in Figure 2-11.

3. A dialogue box appears on the screen. See

Figure 2-13. Type in a filename for the settings file.

Choose a unique name that identifies the system

for future reference. Settings file use the extension

.sdf. Do not type the filename extension; the

program appends the extension to the filename

automatically.

4. The program displays the default directory where

the settings file will be saved. Use the drop-down

arrow to the right of the box to choose a different file

location or click OK to save the file to the default

location shown.

Save

Save in:

Figure 2-13 Save Setup Screen

Procedure to Restore System Settings from a File

1. Select File>Restore Setup from the menu bar.

2. Click on the file containing the appropriate settings

from the list on the screen to select it.

3. Click the Open button. The program changes the

system settings to the values stored in the file.

2.8.3 Exit

Use the File>Exit command to exit the Setup Program

after disconnecting from the ATS (see Section 2.5,

Connection Menu). The program may prompt the

operator to save the screen if the layout has been

changed since the last time it was saved.
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2.9 Edit Menu

The Edit menu allows the user to cut, copy, and paste

selected text. SeeFigure 2-14. With some systems, the

Edit commands can be accessed by clicking the right

mouse button while the setup window is active. This

function depends on the PC mouse properties.

The Cut and Copy commands are enabled only when

text that can be cut or copied is selected. The Paste

command is only enabled when there is text on the

clipboard that is available to paste.

2.10 Help Menu

Choose Help>About... for information about the

software such as the version number and copyright

information. See Figure 2-15. (Help Topics option is not

available at the time of manual printing.)

The About... box displays the software name, version

number, build date, and copyright information. See

Figure 2-16. Click on theOK button to close thewindow.

Click on the System Info button to launch the Microsoft�

system information application if it is available on your

PC.

2.11 System Tray

An icon in the box at the lower right corner of the screen

indicates whether the PC is connected to the controller.

See Figure 2-17. A green icon indicates that the PC is

connected to and communicating with the controller. A

red icon indicates that the devices are not connected.

Check the null modem cable and the selected COMport

(see Section 2.6.3, Options) if there are connection

problems.

Figure 2-14 Edit Menu

Figure 2-15 Help Menu

Test

Figure 2-16 About Box

1

1. Connection icon: green=connected, red=disconnected

Figure 2-17 System Tray

Microsoft� is a registered trademark of Microsoft Corporation
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2.12 Messages

Message windows indicate problems with user names

or passwords as typed. Click on OK to remove the

message box and then try again. Possible messages

include:

� Login. See Figure 2-18. The user name or

password is incorrect. User names and passwords

are case sensitive. Check the spelling of the user

name and password and verify that theCaps Lock on

the keyboard is not activated before retyping. This

message also appears if the user tries to enter an old

user name/password combination.

� Change Password. See Figure 2-19. The new

passwords typed do not match. Check the spelling

and capitalization of the new password carefully, and

then retype it in both boxes of the Change Password

window.

Note: Passwords are case sensitive. Check the

Caps Lock key before typing the password.

� Change User Name. See Figure 2-20. The new

user names typed do notmatch. Check the spelling of

the new user name and retype it.

� Save Screen. See Figure 2-21. The message

shown in Figure 2-21 appears at exit if any display

windows have been added or removed. The Save

Screen command allow the display windows to be

saved and reopened rather than recreating the

windows individually at each use of the program.

Select Yes to save, No to exit without saving, or

Cancel to cancel the exit command and return to the

program. See Section 2.8.1, Save and Open Screen,

for more information about saving screens.

Figure 2-18 Login

Figure 2-19 Change Password

Figure 2-20 Change User Name

Figure 2-21 Save Screen
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Section 3 Setup Software Windows

3.1 Introduction

This section describes display and setup windows.

Select Window>New Window and select an item from

the list to create a display window. Double-click on an

active display window or choose Window>Setup to

create the setup window. Refer to Section 2.7, WIndow

Menu, for more information about creating and working

with setup windows.

A summary table in Section 3.21, Network Interface

Port, lists all of the items contained in each window, and

indicates whether each item is included in both the

display and setup windows. Use the table as a guide to

identify the location of individual settings, time delays, or

other parameters.

3.2 Date/Time Windows

View and set the controller’s time and date settings, or

set the controller’s clock to match the personal

computer’s (PC) clock.

3.2.1 Date/Time Display

The Date/Time display shows the controller’s time and

date settings. The controller’s settings do not

necessarily match those of the PC. See Figure 3-1.

3.2.2 Date/Time Setup

Use the drop-down arrow to display a date list and click

on a date from the list to select it, or select Today at the

bottom of the calendar. Another way to enter the date is

to select the date, month, and year one item at a time

and type the current information into the date box. See

Figure 3-2. Click on the OK button or press Enter to

enter the settings. The clock does not reset until OK is

entered.

Use the up and down arrows to set the time or click the

System Clock button to set the controller’s clock to

match the PC’s time.

3.2.3 Daylight Saving Time

To set the system to automatically reset the clock for

Daylight Saving Time, click in the box so that a check

mark appears. Enter the dates to set the clock ahead in

the spring and back in the fall. Use the drop-down

arrows to bring up a calendar or type the dates into the

box in the same way as described for setting the current

date.

Note: In succeeding years, the controller will reset the

clock on the day of theweek according to the date

set for the first year. For example, if April 7, 2002

is entered, the clock will reset on the first Sunday

in April, 2003, and succeeding years.

The clock resets at 2 a.m. If an exercise is scheduled to

begin between 2 and 3 a.m. on the day that the time

changes, that exercise run will be missed.

Figure 3-1 Date/Time Display

Figure 3-2 Date/Time Setup

3.3 Source Information

The software provides source voltage, frequency, and

phase information for Source N and Source E.

The controller senses voltages on all phases of both

sources over a range of 110 to 600 VAC with an

accuracy of �2%. The controller senses frequency on

both sources with an accuracy of �2%.
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3.3.1 Source Info Display

The Source Info display window shows the following

information for each source. See Figure 3-3. Single-

phase systems will display only the single-phase

parameters shown in Figure 3-4.

� Measured voltage

� Measured frequency

� Number of phases

� Expected phase rotation

� Actual phase rotation

� Nominal system voltage

� Nominal system frequency

3.3.2 Source Info Setup

The Source Info setup window (see Figure 3-5) allows

you to change the following user-adjustable settings for

each source:

� Nominal (rated) voltage

� Nominal (rated) frequency

� Expected rotation (ABC or CBA)

� Number of phases (1 or 3)

Figure 3-3 Source Info Display, Three-Phase

Source

Single- or Three-Phase Operation

Sources can be either single-phase or three-phase.

Single-phase systems will display only the single-phase

parameters as shown in Figure 3-4.

Phase Rotation (Three-Phase Systems)

The default phase rotation setting is ABC. The system

phase rotation setting must match the source phase

rotation; if it does not, use the setup software to change

the phase rotation setting to match the source phase

rotation, ABC or CBA.

Figure 3-4 Source Info Display, Single-Phase

Source

Figure 3-5 Source Info Setup
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3.4 Setpoints, Frequency

The controller senses frequency on both sources with

an accuracy of �2%. The Frequency Setpoints display

window shows the setpoints in percent of the nominal or

the pickup value, and also shows the resulting setting in

Hz. Figure 3-6 shows the frequency setpoints display

window with the factory default settings.

A fault occurs if the frequency of either source falls

outside the dropout or pickup settings for a length of time

longer than the frequency dropout time. If the fault

occurs on the active source, the system attempts to

transfer the load to the alternate source.

3.4.1 Display

The display window shows the pickup and dropout

settings as percentages of the nominal or pickup

frequency as indicated. The resulting values in Hz are

displayed in the column on the right.

The frequency dropout time is displayed in seconds.

3.4.2 Setup

Open the setup window to change the overfrequency

pickup and dropout settings, the underfrequency pickup

and dropout settings, and the frequency dropout time for

each source. The adjustment range is shown to the right

of each data box. The values shown in Figure 3-7 are

the factory default settings.

Click on the data box to be changed and type in the new

value, in percent of nominal or pickup frequency as

indicated to the right of the box. The resulting frequency

will be displayed in the last column. Click onOK to apply

the new settings or Cancel to discard the changes.

Figure 3-6 Frequency Setpoints Display (default

settings shown)

Figure 3-7 Frequency Setpoints Setup (default

settings shown)
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3.5 Setpoints, Voltage

A fault occurs when the voltage of either source falls

outside the dropout or pickup settings for a length of time

longer than the debounce time. If the fault occurs on the

active source, the system attempts to transfer the load

to the alternate source. The debounce time prevents

nuisance transfers caused by brief voltage spikes and

dips.

3.5.1 Display

Figure 3-8 shows the voltage setpoints display window

with the factory default settings. The display window

shows the pickup and dropout settings as percentages

of the nominal dropout or pickup voltage as indicated.

The resulting voltages are shown in the column on the

right.

The voltage debounce time is displayed in seconds.

Figure 3-8 Voltage Setpoints Display (default

settings shown)

3.5.2 Setup

Open the Setup window to change the overvoltage

pickup and dropout settings, the undervoltage pickup

and dropout settings, and the debounce time for each

source. The adjustment range is shown to the right of

each data box. The values shown in Figure 3-9 are the

factory default settings.

Click on the data box to be changed and type in the new

value, in percent of nominal, pickup, or dropout voltage

as indicated to the right of the box. The resulting voltage

will be displayed in the last column. Click onOK to apply

the new settings or Cancel to discard the changes.

Figure 3-9 Voltage Setpoints Setup (default settings

shown)
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3.6 System Information

The System Information windows include load

descriptions, ATS information, and software version

numbers.

3.6.1 System Information Display

The Source Information Display window (see

Figure 3-10) lists the following items:

� System designation

� System location

� Load branch

� Load description

� ATS serial number

� ATS contactor serial number

� ATS Controller serial number

� Software version numbers

� I/O module software version numbers

3.6.2 System Information Setup

The System Information Setup window (see

Figure 3-11) allows changes to the following

information:

� System designation

� System location

� Load branch

� Load description

The serial numbers for the transfer switch, contactor,

and controller are entered at the factory. Software

version numbers are read from the hardware and

cannot be changed with the setup software.

Type in unique descriptions to clearly identify the

system, location, and connected loads. Descriptions

are limited to 20 alphanumeric characters, including

spaces.

Figure 3-10 System Info Display

Name and/or number

Figure 3-11 System Info Setup
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3.7 System Summary

The system summary windows include various system

settings affecting the overall setup of the ATS.

3.7.1 System Summary Display

The Display window shows the transfer switch status.

See Figure 3-12.

System State may indicate System Ready or a fault

condition such as Failure to Acquire Standby. The

controller obtains the system state from the hardware.

Figure 3-13 lists some typical System State messages.

Figure 3-12 System Summary Display

System State Message Notes

System Ready Ready, no fault
conditions

Failure to Acquire Standby See the transfer switch
operation and installation

Failure to Transfer
operation and installation
manual.

I/O Module Comms Lost See Section 3.12.4,
P bl O t t

I/O Module Not Found

,
Programmable Outputs.

I/O Module Not Installed

Aux. Switch Fault See the transfer switch
operation and installation

Aux. Switch Open
operation and installation
manual.

Low Battery on Standby
Source

Low battery on the
standby generator set.

Common Alarm See Section 3.15,
Common Alarms.

Figure 3-13 Typical System State Messages

3.7.2 System Summary Setup

The setup window allows you to change the following

settings (see Figure 3-14):

� Mode of operation: generator set to utility, utility to

utility, or generator set to generator set

� Transition mode: open or programmed

� Rated current

� Number of input/output modules installed

� Commit to transfer: yes (selected) or no (not

selected)

� Peak shave delay bypass: yes (selected) or no (not

selected)

� In-phase monitor: disable or enable and set the

leading or lagging angle

The controller obtains the contactor position, preferred

source, and supervised transfer switch position from the

hardware. These values cannot be changed through

the software.

The supervised transfer mode is factory-set and cannot

be changed in the field. Refer to TP-6126, ATS

operation and installation manual, for information about

automatic and non-automatic switches.

Figure 3-14 System Summary Setup
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Mode of Operation

The system operates in any one of three modes, which

are defined by the power sources. The three modes of

operation are:

� Generator Set-to-Utility Mode

� Utility-to-Utility Mode

� Generator Set-to-Generator Set Mode

The transfer switch is factory-set for the generator

set-to-utility mode of operation. This mode uses one

generator set, which is connected to the Emergency

side of the contactor (Source E), and one engine start

relay. The engine start relay connections are located on

the contactor on 30--400 amp units, and on the

customer-connection terminal block on larger units ( see

TP-6126). The engine start contact is assigned to the

connected generator set and does not change

assignmentwhen the preferred source switch position is

changed. In this mode, if the preferred source switch is

set to Source E, then the system operates the generator

set indefinitely, transferring to utility power only if the

generator set fails.

Change the mode to generator set-generator set or

utility-utility if necessary. The generator set-generator

set mode uses two generator sets and requires the

assignment of a second engine start output. Use the

Programmable Input/Output setup window to assign

one of the main logic board terminal strip or I/O module

outputs to Start Source N Generator, and connect the

engine start leads for the Source N generator set to the

corresponding terminals on the terminal strip or I/O

module terminals. See the ATS operation and

installation manual for connection instructions. The

programmed engine start output remains tied to the

Source N generator set regardless of the position of the

preferred source switch.

The utility-utilitymode is designed for to use utility power

for both Source N and Source E. This mode does not

use the engine start outputs.

Transition Mode

The transition mode, open or programmed, must match

the transfer switch model. Models KCT and KBT are

open-transition switches. Models KCP and KBP are

programmed-transition switches.

Programmed Transition. A programmed-transition

transfer switch provides an off period between

disconnecting the load and transferring it to the other

power source. The adjustable time-off period allows

residual voltages in the load circuits to decay before

connecting to the second source. During the off period,

the ATS main contacts are open and neither source

powers the load.

Programmed-transition model transfer switches require

a programmed-transition contactor and a programmed-

transition interface board (PTIB). The off-to-standby

and off-to-preferred time delays control the length of the

off period. The End Time Delay button and Remote

Bypass command do not override the off-to-Standby

and off-to-preferred time delays.

Use the system configuration software to change the

programmed-transition settings.

Rated Current

Type in the nominal (rated) current for the system,

1--4000 Amps.

Number of I/O Modules

Enter the number of input/output modules that are

installed on the system, 0--4. A fault is generated if the

number of I/O modules expected does not match the

number of modules installed.

Commit to Transfer

Selecting Commit to Transfer ensures that the ATS

completes a transfer sequence to a valid standby

source once initiated. When this parameter is selected,

the pre-transfer load control signal operates as if the

preferred source failed.

If Commit to Transfer is not selected, the ATS will not

transfer to the standby source if the preferred source is

lost but returns before the transfer sequence is

complete.

Peak Shave Delay Bypass

The Peak Shave Delay Bypass operates during the

Peak Shave/Area Protection transfer sequence. The

bypass ignores the engine start and

standby-to-preferred time delays so that the ATS

transfers immediately back to the preferred source

when the peak shave/area protection signal is removed.

The peak shave delay bypass has no effect on the load

control, programmed-transition, or

preferred-to-standby time delays. See the ATS

Operation/Installation manual for more information

about the Peak Shave/Area Protection sequence of

operation.

A check in the box indicates that the peak shave delay

bypass is selected. The bypass is selected by default;

click in the check box to deactivate the bypass if desired.
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In-Phase Monitor

The In-Phase Monitor operates when both sources are

available, such as when transferring from the standby

back to the preferred source. The in-phase monitor

assures that transfer occurs when the phase angles of

the two sources match within a set range (see Transfer

Angle, below), the source frequencies differ no more

than 2 Hz, and both source voltages are within 70% of

the expected line voltage.

Note: Programmed-transition switches do not use the

in-phase monitor option.

The OFF position LED on the user interface panel

flashes at 2 Hz when the in-phase monitor is operating.

Use the system software to select and set up the

in-phase monitor.

Transfer Angle. The in-phase monitor allows transfer

only if the difference between the source phase angles

is less than or equal to the transfer angle. The transfer

angle is adjustable from --20 to 20 degrees. The factory

setting is 0 (zero) degrees. The phase anglemeasuring

accuracy is �5�. Use the system configuration software

to adjust the transfer angle.

Transition Time. The in-phase monitor continues to

monitor and try to synch until the transfer is successful.

There is no time-out period. If the source voltages or

frequencies are out of range, the system waits for both

sources to stabilize and then tries to synch.

3.8 DIP Switch Settings

The DIP switch settings window (see Figure 3-15)

displays the positions of the controller’s DIP switches:

� Maintenance Switch: Transfer Inhibited (displayed in

red) or Permitted

� Test: Loaded or Unloaded

� Exercise: Inhibited or Permitted

� Manual Exercise: 1 Week or 2 week

� Exercise: Loaded or Unloaded

Figure 3-15 DIP Switch Settings

3.9 Active Time Delay

The Active Time Delay window displays the name of the

time delay that is currently being executed, the amount

of time remaining for that delay, and the percent time

elapsed. The bar shows the progression of the time

delay as it runs. See Figure 3-16.

Clicking on the End Time Delay button ends only the

active time delay. Subsequent programmed time delays

will start and run until completion or until the End Time

Delay button is activated for each delay.

The End Time Delay button will not end an exercise or a

programmed-transition (off-to-standby or off-to-preferred)

time delay.

Figure 3-16 Active Time Delay Display
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3.10 Time Delays

View and set the ATS time delays.

3.10.1 Time Delay Display Window

The Time Delay Display window (see Figure 3-17)

includes the following ATS delays:

� Engine Start

� Engine Cooldown

� Preferred to Standby

� Standby to Preferred

� Acquire Standby Source

� In-phase Monitor Synchronization Output

For programmed-transition models, the following

additional time delays are shown:

� Off to Standby

� Off to Preferred

Figure 3-17 Time Delays Display

3.10.2 Time Delay Setup Window

The Time Delay Setup window (see Figure 3-18) allows

the user to change the following ATS delays:

� Engine Start

� Preferred to Standby

� Standby to Preferred

� Engine Cooldown

� Acquire Standby Source

� Inphase Monitor Output

For programmed-transition models, the setup window

allows the following additional time delays to be set:

� Off to Standby

� Off to Preferred

To change the length of a time delay, double-click inside

the data entry box and type in the new setting in

minutes:seconds. Verify that the new setting falls within

the range shown after the data entry box. Values

outside the range will not be accepted. Click on theOK

button or press the Enter key to enter the change.

Figure 3-18 Time Delay Setup
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3.10.3 Time Delays

The table in Figure 3-20 lists system time delays and

their factory settings. Use the system configuration

software to adjust the time delays within the ranges

shown in the table. Refer to the software operation

instructions.

3.11 Load Control Time Delays

Use the Load Control Time Delay windows to view and

adjust the time delays for the load control outputs on the

controller’s main logic board and on the optional

input/output modules. See Section 3.12, Programmable

Input/ Output, to assign load control outputs to the I/O

modules. Figure 3-19 shows the Display window. Use

Figure 3-20 for time delay descriptions.

Two time delay settings apply to each output: the load

disconnect time before transfer and the reconnect time

after transfer. These time delays allow selected loads to

be disconnected and reconnected in steps rather than

all at once.

3.11.1 Display

Figure 3-19 Load Control Time Delay Display

Time Delay Default
Adjustment
Range Description

Source N Engine start 3 sec. 0--6 sec. Delay between the loss of Source E and the activation of the
Source N engine start command.

Source E Engine start 3 sec. Delay between the loss of Source N and the activation of the
Source E engine start command.

Source N Engine cooldown 0 min. Delay between transfer to Source E and the deactivation of the
Source N engine start signal. Allows the generator set to run without
load to cool the engine.

Source E Engine cooldown 0 min. Delay between transfer to Source N and the deactivation of the
Source E engine start signal. Allows the generator set to run without
load to cool the engine.

Preferred to standby 1 sec. Delay between the controller’s detection of an available standby
source and the transfer to that source. Can be set to allow time for
the standby source to stabilize before transfer. (The controller
remains powered as long as either source is available.)

Standby to preferred 15 min.

0--60 min.

Delay between the controller’s detection of an available preferred
source and the transfer to that source. Allows stabilization of the
preferred source before transfer.

Acquire standby source 1 min. Time allowed for the generator set to start during an exercise period.
If the generator set does not start during this time period, a generator
fault is logged and the exercise cycle continues.

In-phase monitor synch

output

3 sec. Delay between the start of the in-phase monitor synch cycle and the
activation of the synchronization command output. See
Section 3.7.2, System Summary Setup.

Off to standby (programmed-

transition only)

1 sec. Time in the off position before transfer to the standby source.
Programmed transition models only.

Off to preferred (programmed-

transition only)

1 sec. Time in the off position before transfer to the preferred source.
Programmed transition models only.

Figure 3-20 Time Delays
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3.11.2 Setup

Use the Setup window to set the duration of each load

control time delay before and after transfer. Enter a time

between 0 seconds and 60minutes into each data entry

box. See Figure 3-21.

Figure 3-21 Load Control Time Delay Setup
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3.12 Programmable Input/Output

View and assign main logic board and programmable

(I/O) module input and output functions. Refer to the

transfer switch Operation and InstallationManual for I/O

connection instructions.

Accidental starting.

Can cause severe injury or death.

Disconnect the battery cables before

working on the generator set.

Remove the negative (--) lead first

when disconnecting the battery.

Reconnect the negative (--) lead last

when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can

cause severe injury or death. Before working on the

generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the

OFFposition. (2) Disconnect thepower to thebattery charger.

(3) Remove the battery cables, negative (--) lead first.

Reconnect the negative (--) lead last when reconnecting the

battery. Follow these precautions to prevent starting of the

generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote

computer.

3.12.1 I/O Display Window

The Programmable Input/Output window shows which

inputs and output functions are assigned to the

controller main logic board terminal strip input and

output terminals and to the I/O Module input and output

terminals.

Themain logic board inputs and outputs are assigned to

the factory default settings shown in Figure 3-22 at

shipment. The I/O module inputs and outputs are

undefined at shipment and must be assigned after

installation.

Bypass/isolation switches have only one programmable

input available for reassignment on the main logic

board. Programmable input 1 is used for a safety

interlock circuit on bypass/isolation switches and is not

available for customer use.

The I/O module address identifies the I/O board and

must match the address DIP switch settings on the I/O

board.

3.12.2 I/O Setup Window

Use the Programmable I/O Setup Window to assign

input and output functions to the main logic board and

I/Omodule input and output terminals. SeeFigure 3-23.

Figure 3-22 Programmable Input/Output Display

Figure 3-23 Programmable Input/Output Setup
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The main logic board provides 2 programmable inputs

and 1 programmable output. Use the Setup window to

assign functions to the following controller main logic

board inputs and output:

� Terminal strip Input 1 (See note.)

� Terminal strip Input 2

� Programmable output

Note: Terminal strip input 1 is available for

field-connection and assignment on standard

switches only. On bypass/isolation switches,

terminal strip Input 1 is factory-assigned and

connected to the Bypass Contactor Disable

function. Do not change the assignment of MLB

input #1 on bypass/isolation switches!

Each I/Omodule provides 2 programmable inputs and 6

programmable outputs. As many as 4 I/O modules can

be added to the ATS, for total of 10 programmable

inputs (9 for bypass/isolation switches) and 25

programmable outputs. Use the dropdown arrows to

select a function for each input or output. Use the up and

down arrows to move to the next I/O module and assign

functions for that board.

Click on theOK button to accept the I/O assignments or

Cancel to discard the changes.

Note: Be sure to select the address of the I/O module

before assigning I/O module inputs and outputs.

The address resets to 1 each time the OK button

is clicked.

The same input or output function can be assigned to

multiple locations on either the controller board or any

attached I/O module. Inputs or outputs assigned the

same function will operate together.

3.12.3 Programmable Inputs

The available input functions are listed in Figure 3-24

and described in more detail after the table.

Battery Low Fault

Peak Shave

Inhibit Transfer

Remote Bypass

Remote Test

Forced Transfer to OFF

Remote Common Fault

Bypass Contactor Disable
(factory-set for bypass switches only)

Figure 3-24 Programmable Inputs

Battery Low Fault. Indicates that a low battery signal

(contact closure) has been received from an external

device. The Service Required LED illuminates steadily

and the system records an event in the Event Log.

Peak Shave Active. Starts the generator set and

transfers to the standby source. The systemattempts to

transfer to the preferred source when the input is

removed or the connected source fails. Ignores the

Time Delay Engine Start and standby-to-preferred time

delays if the peak shave delay bypass is selected (see

Section 3.7.2).

Inhibit Transfer. When activated, this input prevents all

transfers and cuases the Not-in-Auto LED to flash. This

input has the same effect as the Maintenance DIP

switch.

Remote Bypass. This input functions the same way as

the End Time Delay button on the user interface, ending

any time delay that is operating when the input is

activated except for the programmed transition

off-to-preferred and off-to-standby time delays. If more

than one time delay is programmed, a separate input

signal must be sent to end each time delay.

Remote Test. This input has the same effect as

pressing the Test button on the User Interface. It

initiates a system test, which simulates a preferred

source failure and tests the transfer switch operation. If

a system test is running, this input will stop the test. To

stop tests initiated by this input, either deactivate the

input or press the Test button on the user interface.

Forced Transfer to OFF Position. (Programmed

transition units only.) Bypasses all time delays and

immediately moves the contactor from Source E to the

OFF position. The ATS will proceed to transfer to

Source N if it is available. When this input is removed,

the system transfers to the preferred source if it is

available. If the preferred source is not available but the

standby source is available, the system transfers to the

standby source.

Remote Common Fault. Any common fault input

causes the Service Required LED to flash.

Bypass Contactor Switch Disable. This input

disables the transfer switch on bypass/isolation

switches while the contactor is being inserted or

removed. This input is used only on bypass/isolation

switches. It is factory-assigned to programmable input 1

on the main logic board (MLB) terminal strip (TB1

terminals 6 and 7). Do not reassign MLB input 1 on

bypass isolation switches!
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3.12.4 Programmable Outputs

Programmable monitoring, control, and fault detection

outputs are available through the MLB terminal strip on

the controller or through the programmable input/output

(I/O) modules. The table in Figure 3-25 lists the

available programmable outputs.

Not-in-Auto. Any of the following conditions triggers

the Not-in-Auto output:

� The maintenance switch is activated, preventing

automatic transfer.

� Forced transfer to OFF is activated (programmed-

transition models only).

� The Supervised Transfer Control switch is in the

Manual position (non-automatic switches).

Load Control Active. Any of the following conditions

triggers the Load Control Active output:

� A pre- or post-transfer signal is active.

� Programmable load control outputs are active.

� Peak shave/area protection is engaged.

Load Bank Control. This output allows the application

of a load bank to the generator set during the exercise

period if the exerciser is not set to transfer the actual

load.

The controller deactivates the load bank control and

transfers to the standby source if the preferred source is

lost during an exercise period.

Start SourceNGenerator. Use this engine start output

signal for systems that use a generator set for Source N

(Normal Source). This output is always assigned to the

same generator set regardless of the preferred source

selector switch position.

Peak Shave/Area Protection Active. Indicates that

the system is running on the standby source as a result

of a peak shave command.

Non-Emergency Transfer. Active during peak shave,

loaded exercise, and loaded test sequences.

Synchronization Output Command. The

synchronization output command provides a contact

closure after the in-phase monitor synch output time

delay to indicate that the synch output time delay has

expired.

Programmable Output Type

Preferred Source Available Monitor

Standby Source Available Monitor

Contactor Preferred Selected Monitor

Contactor Standby Selected Monitor

Contactor in OFF position* Monitor

Contactor Source N Selected Monitor

Contactor Source E Selected Monitor

Not in Auto Monitor

Load Control Active Monitor

Low Backup Battery Indicator Monitor

Exerciser Active Monitor

Test Active Monitor

Peak Shave/Area Protection Active Monitor

Non-Emergency Transfer Monitor

Load Bank Control Control

Start Source N Generator Control

Start Source E Generator Control

Synchronization Output Command Control

Common Alarm Fault

Undervoltage Source N Fault

Overvoltage Source N Fault

Loss of Phase Source N Fault

Phase Rotation Error Source N Fault

Overfrequency Source N Fault

Underfrequency Source N Fault

Undervoltage Source N Fault

Overvoltage Source E Fault

Loss of Phase Source E Fault

Phase Rotation Error Source E Fault

Overfrequency Source E Fault

Underfrequency Source E Fault

Failure to Acquire Standby Source Fault

I/O Module Lost Fault

I/O Module Not Found Fault

I/O Module Not Installed Fault

Failure to Transfer Fault

Auxiliary Switch Fault Fault

Auxiliary Switch Open Fault

Load Shed Control Output Control

Software-Controlled Relay Driver Output #1 � Control

Software-Controlled Relay Driver Output #2 � Control

Software-Controlled Relay Driver Output #3 � Control

Software-Controlled Relay Driver Output #4 � Control

* Programmed-transition switches only
� Abbreviated SCRDO #1--4

Figure 3-25 Available Programmable Outputs
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Load Control Outputs. The load control output allows

controlled disconnection of selected loads before

transfer and reconnection in steps after transfer. The

Load Control Time Delays determine the disconnect

time before transfer and reconnect time after transfer. If

one source is lost, the outputs are activated immediately

and then deactivated after the reconnect time delays.

Set the disconnect time before transfer and reconnect

time after transfer through the Load Control Time Delay

window. The times are adjustable from 1 second to

60 minutes. See Section 3.11, Load Control Time

Delays, for information about setting the load control

time delays.

Select up to nine sequential load control outputs, 0--8.

Load control output 0 is always assigned to the main

logic board pre-transfer signal output (TB1 terminals 1

and 2). Outputs 0--8 can be assigned to any position on

an I/O module board or to the programmable output on

the controller board terminal strip. The same function

can be assigned to more than one output.

Modbus�-Controlled Relay Driver Outputs

(SCRDOs). Use these outputs to transmit signals from

aModbus�master through the ATS controller (acting as

a Modbus slave) to connected equipment. Contact

Kohler Co. for Modbus communications protocol

information.

I/O Module Not Found. If the system does not detect

an I/O module at an expected address, the Service

Required LED flashes and the software logs the

message I/O Module Not Found. Check that the

number of I/O modules installed matches the number

expected by the setup program. Check that the I/O

modules are connected and the address DIP switches

are set correctly. Check the diagnostic LED to verify that

the module is receiving power and communicating with

the controller.

I/OModuleNot Installed. If the software detects an I/O

module that is connected but not expected by the setup

program, the Service Required LED flashes and the

software logs the message I/O Module Not Installed.

The system ignores the board if it does not find the setup

definition. Check that the number of I/O modules

expected in the Setup Program matches the number of

modules installed on the transfer switch. Check that the

I/O module address DIP switches are set correctly.

Check the diagnostic LED.

I/O Module Communications Lost. If communication

to an I/O module that was previously installed and

working is lost, the Service Required LED flashes and

the software logs the message I/O Module

Communications Lost. Check the I/O module

connections and diagnostic LED.

Common Alarm. The common alarm output is

activated when any of the fault conditions assigned in

the Common Alarms window occurs. See Section 3.15,

Common Alarms, for more information about assigning

common alarms.

3.13 Exerciser

View and adjust the plant exerciser settings that are not

directly related to the Calendar mode.

Accidental starting.

Can cause severe injury or death.

Disconnect the battery cables before

working on the generator set.

Remove the negative (--) lead first

when disconnecting the battery.

Reconnect the negative (--) lead last

when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can

cause severe injury or death. Before working on the

generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the

OFFposition. (2) Disconnect thepower to thebattery charger.

(3) Remove the battery cables, negative (--) lead first.

Reconnect the negative (--) lead last when reconnecting the

battery. Follow these precautions to prevent starting of the

generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote

computer.

Modbus� is a registered trademark of Schneider Electric.
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3.13.1 Exerciser Display Window

The plant exerciser display window (see Figure 3-26)

displays the following:

� Exerciser Mode: Manual Mode, Calendar Mode, or

Calendar Mode with Override

� Warnings Window:

� EXERCISE INHIBITED: displays in red if the

Exercise Inhibit DIP switch is set to the ON position

� TRANSFER INHIBITED: displays in red if the

Transfer Inhibit DIP switch is set to the ON position

� Manual Exercise:

� Next Run Date

� Next Run Time

� Period

� Loaded/Unloaded

� Run Time

The period, 1 week or 2 weeks, determines how often

the exerciser runs. The run time shows the duration of

each exercise run. The 1 week/2 week period and

loaded/unloaded exercise are set by DIP switches on

the controller’smain logic board. See the ATS operation

and installation manual for more information about DIP

switches.

Figure 3-26 Exercise Display

3.13.2 Exerciser Setup Window

Use the plant exerciser setup window (see Figure 3-27)

to set or adjust the following:

� Exerciser Mode: Manual Mode, Calendar Mode, or

Calendar Mode with Override

� Manual Exercise:

� Next Run Date

� Next Run Time

� Period

� Loaded/Unloaded

� Run Time

The Manual Exercise Disable and Set/End buttons

allow control of the manual exerciser through the

software. Selecting the Disable button clears the

manual exercise settings. Clicking on the Push to

Set/End button when the exerciser is in manual mode

has the same effect as pressing the Exercise button on

the ATS user interface, starting or ending an exercise

run.

Use the Calendar Mode or Calendar Mode with

Override buttons in the exercise setup window to enter

the exerciser Calendar mode. Refer to Section 3.14,

Exercise Calendar, for more information about the

Calendar and Calendar with Override modes.

Figure 3-27 Exercise Setup
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3.14 Exercise Calendar

The calendar provides a method to schedule the

exerciser that is more flexible than using the 1 week/

2 week DIP switch on the transfer switch’s main logic

board. Use the calendar mode to plan up to 21 exercise

events that repeat daily, weekly, or monthly, and choose

whether each event runs with or without load.

Use the Calendar Mode or Calendar Mode with

Override buttons in the Exercise Setup window to enter

the exerciser Calendar modes.

The Calendar Mode and Calendar Mode with Override

settings override the 1 week/2 week and loaded/

unloaded DIP switch settings.

Exercise Button Function in Calendar Modes

� Calendar Mode. In Calendar mode, pressing the

Exercise button does not change the exercise mode

or settings. The Exercise LED flashes quickly for two

seconds if the Exercise button is pressed when the

system is in Calendar Mode.

� Calendar Mode with Override. In Calendar Mode

with Override, pressing and holding the Exercise

button on the ATS user interface until the Exercise

LED flashes overrides and disables the calendar

settings. The calendar settings are saved for future

use, but the exerciser runs inmanual mode until reset

to Calendar Mode or Calendar Mode with Override

through the software.

3.14.1 Calendar Display Window

The Calendar Display Window (see Figure 3-28) shows

the following plant exerciser information. If an exercise

event is disabled, the line is grayed out.

� Event No.

� Start Date

� Start Time

� Run Time

� Loaded or Unloaded

� Exercise period/Interval

3.14.2 Calendar Setup Window

Use the setup window to set up to 21 exerciser run

times, intervals, repeat rates, and loaded/unloaded

condition. See Figure 3-29 for the Calendar Setup

window.

Enabled or Disabled. Clicking on this box so that the

check mark disappears disables that scheduled

exercise event so that it does not run. The event

remains on the calendar so that it can be enabled again

at a later time.

Start Date. There are several ways to select the start

date. Clicking on themonth or year reveals up and down

arrows that allow you to step up or down to the desired

month or year. Selecting the drop-down arrow to right of

the data entry box brings up a calendar. Click on the red

circle at the bottom to select the current day or use the

arrow buttons at the top of the calendar to step to the

desired month and then click on the desired start date.

Start Time. Click on the hour, minute, or AM/PM so that

the desired section is highlighted on the screen. Then

use the arrows to step to the desired hour, minute, or

AM/PM setting or type in the setting from the keyboard.

Figure 3-28 Calendar Mode Display
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Run Time. This setting determines the duration of the

exercise run. Run times over 60 minutes will be

automatically converted to hours:minutes. The

maximum run time is 24 hours.

Loaded or Unloaded. A check in the box in the Loaded

column indicates a loaded exercise. If the box is not

checked, the exercisewill start and run the generator set

without transferring the load. Click on the box to select

or deselect it. This setting overrides the loaded/

unloaded DIP switch setting on the main logic board.

Interval. (daily, weekly, monthly, or the same day every

month) This setting overrides the 1 week/2 week DIP

switch setting on the controller’s main logic board. This

setting works with the repeat rate to set the time interval

between exercise runs.

The Day of Month selection allows you to set the

exerciser to run on the same day every month. For

example, the exerciser can be set to run the first Sunday

of every month. Use caution with the Day of Month

selection. For example, selecting Day of Month on the

5th Friday of the month will cause the exerciser to run

only during months that have five Fridays.

Repeat Rate. The repeat rate and interval set the time

interval between exercise runs. For example, if Day is

selected in the interval column, and 5 is entered as the

repeat rate, then the exercise will repeat every 5 days.

Double-click inside the Repeat Rate data box to

highlight the contents, then type in a number between 1

and 12. Attempts to enter a number outside the

acceptable range cause the box to turn red. Values

outside the acceptable range are not accepted by the

program.

Figure 3-29 Calendar Mode Setup
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3.15 Common Alarms

Use the Common Alarms windows to assign and view

the events assigned to the controller’s common alarm.

Any fault condition assigned to the Common Alarm

triggers the Common Alarm programmable output. See

Section 3.12.4, Programmable Outputs, for more

information about programmable outputs.

3.15.1 Common Alarms Display Window

This window displays the events that are assigned to the

controller’s common alarm. See Figure 3-30 for an

example of the Common Alarms Display window with a

number of assigned events.

Figure 3-30 Common Alarms Display

3.15.2 Common Alarm Setup Window

The common alarms setup window displays a list of all

events that can be assigned as common alarms. See

Figure 3-31. Select an event from the list and click on the

Add button to assign it as a common alarm. The event

will move from the Available window to the Assigned

window. Use theRemove button to remove an assigned

event.

To assign or remove a block of events, click on the first

event in the list, then hold down theShift key and click on

the last event in the block. To select several individual

events, hold down the control (Ctrl) key while clicking on

each event. Use the Add or Remove key to move all of

the highlighted events.

Refer to Figure 3-32 for a typical list of events that can

be assigned as common alarms.

Figure 3-31 Common Alarm Setup
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Preferred Source Available Source N Undervoltage

Contactor in Preferred Position Source N Overvoltage

Contactor in Standby Position Source N Loss of Phase

Contactor in Off Position Source N Phase Rotation Error

Contactor in Source N Position Source N Overfrequency

Contactor in Source E Position Source N Underfrequency

Not in Auto Source E Undervoltage

Load Control Active Source E Overvoltage

Exerciser Started Source E Loss of Phase

Test Mode Active Source E Phase Rotation Error

Peak Shave Active Source E Overfrequency

Non-Emergency Transfer Source E Underfrequency

Load Bank Activate Failure to Acquire Standby

In-Phase Monitor Waiting for Synch Failure to Transfer

Modbus-controlled RDO #1 I/O Module Comms Lost

Modbus-controlled RDO #2 I/O Module Not Found

Modbus-controlled RDO #3 I/O Module Not Installed

Modbus-controlled RDO #4 Aux. Switch Fault

System Ready Aux. Switch Open

Source N Available Remote Common Alarm

Source E Available Critical (immediate) Service Required

Low Battery on Standby Source Non-Critical Service Required

Figure 3-32 Typical Common Alarms
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3.16 Event History

View, save, and clear the controller’s event log. The

Event History window displays the time, date, and

duration of the last loss of the preferred source. The

window also displays all events in the controller’s event

log, with the time, date, and up to two other parameters

associated with the event. The window displays up to

100 events. See Figure 3-33.

ThemessageEEPROMAccessWarningmay appear in

the event log. If the EEPROM warning message

appears repeatedly, call for service.

Press theSaveHistory button to save the event log in an

ASCII text file. The system allows the user to select the

location to save the file.

The system logs up to 100 time- and date-stamped

events and faults. Press the Clear History button to

empty the log. If events have been added since the last

time the log was saved, the program asks for

confirmation before clearing the log.

Figure 3-33 Event History Display
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3.17 Maintenance

3.17.1 Maintenance Display Window

The Maintenance Display window shows the totals and

the maintenance records since the last maintenance

reset for the items listed in Figure 3-36. Figure 3-34

shows the Display window.

3.17.2 Maintenance Setup Window

The Maintenance Setup window contains software

buttons that allow you to reset the maintenance records

and reload the factory default controller settings. See

Figure 3-35.

Reload Defaults resets all of the system parameters,

including system voltage and frequency settings,

voltage and frequency pickup and dropout setpoints,

time delays, input and output assignments, exerciser

settings and schedules, and any other settings that have

been changed since receipt of the unit. All settings will

need to be checked and reset after selecting theReload

Defaults button.

Use the Reset Maintenance Records button after

servicing the switch to update the maintenance records

shown in the maintenance display window. See

Figure 3-36.

Buttons that appear gray on the setup screen are not

accessible.

Figure 3-34 Maintenance Display

Figure 3-35 Maintenance Setup

Historical Data Types

Item Units Description

Time in Operation Minutes Minutes the switch has been under power since leaving the factory

In Standby Minutes Minutes the switch operated in the Emergency position

Hours Not in Preferred Minutes Minutes the switch operated in any position other than the preferred position

Switch Transfers N/A Number of transfers the switch has completed

Failure to Transfer N/A The number of time that the contactor failed to transfer when commanded

Lost Preferred Source N/A Number of times the switch has lost the preferred power source

System Startup Date N/A The date the system was first started on site

Last Maintenance Reset Date N/A Date of last maintenance record reset

Transfer time N to E mS Milliseconds (not adjustable)

Transfer time E to N mS Milliseconds (not adjustable)

Figure 3-36 Maintenance Records
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3.18 Manual Operation

The Manual Operation window (see Figure 3-37)

includes the following items:

� Peak Shave Start and Stop buttons

� System Test Start and Stop buttons

� Programmed-Transition Transfer to OFF button

� Modbus� Controlled Relay Outputs

There is no setup function for the Manual Operation

window.

Manual transfer operations are inhibited if the

Maintenance DIP swith is set to inhibit transfer.

Figure 3-37 Manual Operation

Accidental starting.

Can cause severe injury or death.

Disconnect the battery cables before

working on the generator set.

Remove the negative (--) lead first

when disconnecting the battery.

Reconnect the negative (--) lead last

when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can

cause severe injury or death. Before working on the

generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the

OFFposition. (2) Disconnect thepower to thebattery charger.

(3) Remove the battery cables, negative (--) lead first.

Reconnect the negative (--) lead last when reconnecting the

battery. Follow these precautions to prevent starting of the

generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote

computer.

PeakShave. Select theStart button to activate the peak

shave function and initiate peak shave operation. The

ATS starts the standby generator set and transfers the

load to the standby source until the peak shave input is

deactivated through the software. Refer to the transfer

switch operation and installation manual for more

information about the Peak Shave sequence of

operation.

Note: A peak shave input signal overrides the software

buttons.

Test. Use the software buttons to start or end a system

test. The Test button on the user interface remains

functional, so that a test started by the software can be

ended by pressing the Test button on the user interface,

and a test started by pressing the button on the user

interface can be ended by clicking on the Stop button in

the software.

Note: A test input signal overrides the software buttons.

Programmed Transition. The programmed-transition

buttons are disabled if the transfer switch is not a

programmed-transition model. Select the Transfer to

OFF button to force the transfer switch from the

Emergency (Source E) position to the OFF position.

The switch then transfers to Source N if it is available.

The Transfer to OFF button does not function when the

transfer switch is in the normal (Source N) position.

Note: A forced transfer to OFF input signal overrides

the software buttons.

Select the Resume Normal Ops button to end the

Transfer to OFF function. The ATS will transfer to the

preferred source, if available, according to the controller

settings.

Refer to the ATS operation and installation manual for

more information about the Forced Transfer to OFF

(load shed) sequence of operation.

Modbus� is a registered trademark of Schneider Electric.
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Modbus�-Controlled Relay Outputs. The buttons

allow activation of Modbus�-controlled outputs

assigned to the programmable outputs on the Main

Logic Board or I/OModules. The button displaysOutput

OFF when the output is off. Clicking on the button

activates the output. The button displays Output ON.

Click on it again to deactivate the output.

3.19 Meter Calibration

The transfer switch controls are calibrated at the factory

and should not require recalibration in the field.

However, if recalibration is necessary, use the meter

calibration window. See Figure 3-38 and Figure 3-39.

Hazardous voltage.

Will cause severe injury or death.

Only authorized personnel should

open the enclosure.

DANGER

Testing live electrical circuits. Hazardous voltage or

current cancausesevere injury ordeath. Have trainedand

qualified personnel take diagnostic measurements of live

circuits. Use adequately rated test equipment with electrically

insulated probes and follow the instructions of the test

equipment manufacturer when performing voltage tests.

Observe the following precautions when performing voltage

tests: (1) Remove all jewelry. (2) Stand on a dry, approved

electrically insulated mat. (3) Do not touch the enclosure or

components inside the enclosure. (4) Be prepared for the

system to operate automatically.

(600 volts and under)

Use a voltmeter to measure the voltages across each

circuit shown, enter the measured values in the

appropriate data entry box, and click on Apply to

calibrate the controller’s voltage measurements.

Figure 3-38 Meter Calibration, Three-Phase Units

Figure 3-39 Meter Calibration, Single-Phase Units
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3.20 Network Interface Port

View and set the address, baud rate, and parity of the

Modbus� network interface port to match the other

devices in the network. See Figure 3-40. This window

does not display or change the settings of the Modbus�

setup slave port.

The ATS operation and installation manual contains

instructions and cable recommendations for making

Modbus� connections to the transfer switch.

3.20.1 Network Interface Port Display

Window

View the address and baud rate of theModbus� network

interface port.

3.20.2 Network Interface Port Setup

Window

Set up the Modbus� network interface port to

communicate with the other devices in the network. See

Figure 3-41.

Choose a unique network address for each device in the

network. Type in the address or use the up and down

arrows. Choose the baud rate from the drop-down list.

Allowable baud rates are 9600 and 19200 baud. Select

the baud rate tomatch the other devices on the network.

Figure 3-40 Network Interface Port

Figure 3-41 Network Interface Port Setup

Modbus� is a registered trademark of Schneider Electric.
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3.21 Software Window Summary

Window Display Setup Item Notes

Source Info � Voltage A--B Actual voltages, three-phase systems

� Voltage B--C

g , p y

� Voltage C--A

� Voltage A--N

� Voltage B--N

� Voltage C--N

� Voltage L1--L2 Actual voltage, single-phase systems

� Frequency Actual frequency

� Actual Rotation Three-phase systems

� � Phases Number of phases detected

� � Expected Rotation ABC or CBA

� � System Voltage Nominal

� � System Frequency Nominal

Setpoints--
F

� � Underfreq Dropout See Section 3.4, Setpoints-Frequencyp
Frequency

� � Underfreq Pickup

, p q y

� � Overfreq Dropout

� � Overfreq Pickup

� � Freq Dropout Time

Setpoints--
V l

� � Undervoltage Dropout See Section 3.5, Setpoints-Voltagep
Voltage

� � Undervoltage Pickup

, p g

� � Overvoltage Dropout

� � Overvoltage Pickup

� � Voltage Debounce Time

System
I f i

� � Designation Enter unique description to identify the transfer
i h d l d

y
Information

� � Location

q p y
switch and loads

� � Load Branch

� � Load Description

� ATS Serial No. Factory-set, not accessible in the field

� Contactor Serial No.

y ,

� Controller Serial No.

� Device ID

� Software Version Nos.

System
S

� System State See Section 3.7, System Summaryy
Summary

� Contactor Position N, E, or OFF (programmed-transition only)

� Preferred Source N or E

� � Mode of Operation Generator Set to Utility, Utility to Utility, or Generator
Set to Generator Set

� � Transition Mode Open or Programmed-Transition

� Supervised Transfer Mode Automatic Override or Non-Automatic

� Supervised Transfer Swtich
Position

Auto or Manual

� � Commit to Transfer Enabled or Disabled

� � Peak Shave Delay Bypass Enabled or Disabled

� � In-Phase Monitor Enabled or Disabled

� � In-Phase Monitor Transfer
Angle

--20 to 20 degrees, leading or lagging

� � Rated Current Amps

� � Number of I/O Modules
Expected

Maximum of 4
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Window NotesItemSetupDisplay

Active Time
D l

� Name of active time delay See Section 3.9, Active Time Delay
Delay

� Time remaining, seconds

, y

� Percent time delay elapsed

� Elapsed time graphic display

� End Delay Button ends an active time delay

Does not end programmed-transition time delays or
an exercise run

See Section 3.9, Active Time Delay

Time Delays � � Source N Engine Start See Section 3.10, Time Delaysy

� � Source E Engine Start

, y

� � Preferred to Standby

� � Standby to Preferred

� � Source N Engine Cooldown

� � Source E Engine Cooldown

� � Acquire Standby Source

� � In-Phase Monitor Synch

� � Off to Standby Programmed Transition Models only

� � Off to Preferred Programmed Transition Models only

Load Control
Time Delays

� � Main Logic Board Load
Control

Separate time delays for disconnect before transfer
and reconnect after transfery

� � I/O Module Load Control
#1--8

Separate time delays for transfers from Source N to
E and from Source E to N

Programmable
I /O

� � Terminal Strip Input #1 Main Logic Boardg
Input/Output

� � Terminal Strip Input #2

g

� � Programmable Output

� � I/O Module Address Input/Output Modules

� � Input Event #1

p / p

� � Input Event #2

� � Outputs 1--6

Exerciser � � Manual Mode Select exerciser mode

� � Calendar Mode with Override Select button in setup window to enter Calendar
Mode with Override

� � Calendar Mode Select button in setup window to enter Calendar
Mode

� Exercise Inhibited Displays if the Inhibit Exercise DIP switch is activated

� Transfer Inhibited Displays if the Inhibit Transfer DIP switch is activated

� � Next Manual Exercise Start
Date

See Section 3.13

� � Next Manual Exercise Start
Time

� � Manual Exercise Period

� � Manual Exercise
Loaded/Unloaded

DIP switch setting

� � Manual Exercise Run Time Hrs:min.

� Manual Exercise Disable Button

� Push to Set/End Button allows remote start/stop of exercise run

Exerciser
C l d

� Event Number See Section 3.13, Exerciser
Calendar

� � Next Start Date

,

� � Start Time

� � Run Time (hr:min)

� � Loaded (Unloaded)

� � Exercise Interval

� Repeat Rate
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Window NotesItemSetupDisplay

Event History � Lost Preferred Source Displays time, date, and duration of last occurrencey

� Other Events Displays up to 100 events

� Clear History Button

� Save History Button

Common
Al

� � Assigned Events Lists events that are assigned as common faults
Alarms

� Available Events Use setup to choose common faults from a list of all
available events

DIP Switch
Settings

� Transfer Inhibited
(Red)/Permitted (Black)

Displays the positions of the controller DIP switches
g

� Loaded/Unloaded Test

� Exercise Inhibited/Permitted

� 1 Week/2 Week Manual
Exercise

� Loaded/Unloaded Exercise

Date/Time � � Date Does not necessarily match the PC’s date

Can synch with PC

Daylight Savings Time feature available

� � Time Does not necessarily match the PC clock

Can synch with PC

� System Clock Select button to set time and date to match the PC
system clock

� Daylight Saving Time Check box to select DST and date boxes to set clock
ahead and back

Network
I f P

� � Address Use to set up the Modbus� network port, not the
Interface Port

� � Baud Rate

Use to set up the Modbus network port, not the
Modbus setup port

Maintenance
R d

� Not in Preferred Hours, total and since last reset
Records

� In Standby

,

� Operation Time Total and since last reset

� Switch Transfers

� Lost Preferred Source

� Failures to Transfer

� System Start Date Month/Day/Year

� Last Maintenance Reset Date

/ y/

Factory setting

� Transfer Time N to E Factory setting

� Transfer Time E to N

y g

� Reset Maintenance Records Button resets the maintenance history and date of
last maintenance

� Reload Defaults Resets all system settings—Use with caution!

Meter
Calibration

Voltages Measure and enter voltages for Source N and
Source E

Manual
Operation

� Peak Shave Start and Stop buttons

Disabled if transfer inhibit DIP switch is set to ON

� System Test Start and Stop buttons

Disabled if transfer inhibit DIP switch is set to ON

� Programmed Transition Transfer to Off and Resume Normal Ops Buttons

Disabled in standard-transition models or if transfer
inhibit DIP switch is set to ON

� Modbus� -Controlled Relay
Outputs

Buttons 1 through 4 to toggle relay outputs on or off

Figure 3-42 Window Summary
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Appendix A Abbreviations

The following list contains abbreviations that may appear in this publication.

A, amp ampere

ABDC after bottom dead center

AC alternating current

A/D analog to digital

ADC analog to digital converter

adj. adjust, adjustment

ADV advertising dimensional
drawing

AHWT anticipatory high water
temperature

AISI American Iron and Steel
Institute

ALOP anticipatory low oil pressure

alt. alternator

Al aluminum

ANSI American National Standards
Institute
(formerly American Standards
Association, ASA)

AO anticipatory only

API American Petroleum Institute

approx. approximate, approximately

AR as required, as requested

AS as supplied, as stated, as
suggested

ASE American Society of Engineers

ASME American Society of
Mechanical Engineers

assy. assembly

ASTM American Society for Testing
Materials

ATDC after top dead center

ATS automatic transfer switch

auto. automatic

aux. auxiliary

A/V audiovisual

avg. average

AVR automatic voltage regulator

AWG American Wire Gauge

AWM appliance wiring material

bat. battery

BBDC before bottom dead center

BC battery charger, battery
charging

BCA battery charging alternator

BCI Battery Council International

BDC before dead center

BHP brake horsepower

blk. black (paint color), block
(engine)

blk. htr. block heater

BMEP brake mean effective pressure

bps bits per second

br. brass

BTDC before top dead center

Btu British thermal unit

Btu/min. British thermal units per minute

C Celsius, centigrade

cal. calorie

CARB California Air Resources Board

CB circuit breaker

cc cubic centimeter

CCA cold cranking amps

ccw. counterclockwise

CEC Canadian Electrical Code

cert. certificate, certification, certified

cfh cubic feet per hour

cfm cubic feet per minute

CG center of gravity

CID cubic inch displacement

CL centerline

cm centimeter

CMOS complementary metal oxide
substrate (semiconductor)

cogen. cogeneration

com communications (port)

coml commercial

Coml/Rec Commercial/Recreational

conn. connection

cont. continued

CPVC chlorinated polyvinyl chloride

crit. critical

CRT cathode ray tube

CSA Canadian Standards
Association

CT current transformer

Cu copper

cu. in. cubic inch

cw. clockwise

CWC city water-cooled

cyl. cylinder

D/A digital to analog

DAC digital to analog converter

dB decibel

dBA decibel (A weighted)

DC direct current

DCR direct current resistance

deg., � degree

dept. department

dia. diameter

DI/EO dual inlet/end outlet

DIN Deutsches Institut fur Normung
e. V.
(also Deutsche Industrie
Normenausschuss)

DIP dual inline package

DPDT double-pole, double-throw

DPST double-pole, single-throw

DS disconnect switch

DVR digital voltage regulator

E, emer. emergency (power source)

EDI electronic data interchange

EFR emergency frequency relay

e.g. for example (exempli gratia)

EG electronic governor

EGSA Electrical Generating Systems
Association

EIA Electronic Industries
Association

EI/EO end inlet/end outlet

EMI electromagnetic interference

emiss. emission

eng. engine

EPA Environmental Protection
Agency

EPS emergency power system

ER emergency relay

ES engineering special,
engineered special

ESD electrostatic discharge

est. estimated

E-Stop emergency stop

etc. et cetera (and so forth)

exh. exhaust

ext. external

F Fahrenheit, female

fglass. fiberglass

FHM flat head machine (screw)

fl. oz. fluid ounce

flex. flexible

freq. frequency

FS full scale

ft. foot, feet

ft. lbs. foot pounds (torque)

ft./min. feet per minute

g gram

ga. gauge (meters, wire size)

gal. gallon

gen. generator

genset generator set

GFI ground fault interrupter

GND, ground

gov. governor

gph gallons per hour

gpm gallons per minute

gr. grade, gross

GRD equipment ground

gr. wt. gross weight

H x W x D height by width by depth

HC hex cap

HCHT high cylinder head temperature

HD heavy duty

HET high exhaust temperature,
high engine temperature

hex hexagon

Hg mercury (element)

HH hex head

HHC hex head cap

HP horsepower

hr. hour

HS heat shrink

hsg. housing

HVAC heating, ventilation, and air
conditioning

HWT high water temperature

Hz hertz (cycles per second)

IC integrated circuit

ID inside diameter, identification

IEC International Electrotechnical
Commission

IEEE Institute of Electrical and
Electronics Engineers

IMS improved motor starting

in. inch

in. H2O inches of water

in. Hg inches of mercury

in. lbs. inch pounds

Inc. incorporated

ind. industrial

int. internal

int./ext. internal/external

I/O input/output

IP iron pipe

ISO International Organization for
Standardization

J joule

JIS Japanese Industry Standard
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k kilo (1000)

K kelvin

kA kiloampere

KB kilobyte (210 bytes)

kg kilogram

kg/cm2 kilograms per square
centimeter

kgm kilogram-meter

kg/m3 kilograms per cubic meter

kHz kilohertz

kJ kilojoule

km kilometer

kOhm, k� kilo-ohm

kPa kilopascal

kph kilometers per hour

kV kilovolt

kVA kilovolt ampere

kVAR kilovolt ampere reactive

kW kilowatt

kWh kilowatt-hour

kWm kilowatt mechanical

L liter

LAN local area network

L x W x H length by width by height

lb. pound, pounds

lbm/ft3 pounds mass per cubic feet

LCB line circuit breaker

LCD liquid crystal display

ld. shd. load shed

LED light emitting diode

Lph liters per hour

Lpm liters per minute

LOP low oil pressure

LP liquefied petroleum

LPG liquefied petroleum gas

LS left side

Lwa sound power level, A weighted

LWL low water level

LWT low water temperature

m meter, milli (1/1000)

M mega (106 when used with SI
units), male

m3 cubic meter

m3/min. cubic meters per minute

mA milliampere

man. manual

max. maximum

MB megabyte (220 bytes)

MCM one thousand circular mils

MCCB molded-case circuit breaker

meggar megohmmeter

MHz megahertz

mi. mile

mil one one-thousandth of an inch

min. minimum, minute

misc. miscellaneous

MJ megajoule

mJ millijoule

mm millimeter

mOhm, m�
milliohm

MOhm, M�
megohm

MOV metal oxide varistor

MPa megapascal

mpg miles per gallon

mph miles per hour

MS military standard

m/sec. meters per second

MTBF mean time between failure

MTBO mean time between overhauls

mtg. mounting

MW megawatt

mW milliwatt

�F microfarad

N, norm. normal (power source)

NA not available, not applicable

nat. gas natural gas

NBS National Bureau of Standards

NC normally closed

NEC National Electrical Code

NEMA National Electrical
Manufacturers Association

NFPA National Fire Protection
Association

Nm newton meter

NO normally open

no., nos. number, numbers

NPS National Pipe, Straight

NPSC National Pipe, Straight-coupling

NPT National Standard taper pipe
thread per general use

NPTF National Pipe, Taper-Fine

NR not required, normal relay

ns nanosecond

OC overcrank

OD outside diameter

OEM original equipment
manufacturer

OF overfrequency

opt. option, optional

OS oversize, overspeed

OSHA Occupational Safety and Health
Administration

OV overvoltage

oz. ounce

p., pp. page, pages

PC personal computer

PCB printed circuit board

pF picofarad

PF power factor

ph., � phase

PHC Phillips head crimptite (screw)

PHH Phillips hex head (screw)

PHM pan head machine (screw)

PLC programmable logic control

PMG permanent-magnet generator

pot potentiometer, potential

ppm parts per million

PROM programmable read-only
memory

psi pounds per square inch

pt. pint

PTC positive temperature coefficient

PTO power takeoff

PVC polyvinyl chloride

qt. quart, quarts

qty. quantity

R replacement (emergency)
power source

rad. radiator, radius

RAM random access memory

RDO relay driver output

ref. reference

rem. remote

Res/Coml Residential/Commercial

RFI radio frequency interference

RH round head

RHM round head machine (screw)

rly. relay

rms root mean square

rnd. round

ROM read only memory

rot. rotate, rotating

rpm revolutions per minute

RS right side

RTV room temperature vulcanization

SAE Society of Automotive
Engineers

scfm standard cubic feet per minute

SCR silicon controlled rectifier

s, sec. second

SI Systeme international d’unites,
International System of Units

SI/EO side in/end out

sil. silencer

SN serial number

SPDT single--pole, double--throw

SPST single--pole, single--throw

spec, specs
specification(s)

sq. square

sq. cm square centimeter

sq. in. square inch

SS stainless steel

std. standard

stl. steel

tach. tachometer

TD time delay

TDC top dead center

TDEC time delay engine cooldown

TDEN time delay emergency to
normal

TDES time delay engine start

TDNE time delay normal to
emergency

TDOE time delay off to emergency

TDON time delay off to normal

temp. temperature

term. terminal

TIF telephone influence factor

TIR total indicator reading

tol. tolerance

turbo. turbocharger

typ. typical (same in multiple
locations)

UF underfrequency

UHF ultrahigh frequency

UL Underwriter’s Laboratories, Inc.

UNC unified coarse thread (was NC)

UNF unified fine thread (was NF)

univ. universal

US undersize, underspeed

UV ultraviolet, undervoltage

V volt

VAC volts alternating current

VAR voltampere reactive

VDC volts direct current

VFD vacuum fluorescent display

VGA video graphics adapter

VHF very high frequency

W watt

WCR withstand and closing rating

w/ with

w/o without

wt. weight

xfmr transformer
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